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Abstract

This paper is a guide for Battcon conference attendees presenting a paper at Battcon. This paper addresses the
requirements for submitting a paper, paper approval and selection, paper formatting, and due dates for
components of the presentation. An Abstract section such as this one is optional and not required.

Introduction

This paper is a guide for preparing your paper for the Battcon Stationary Battery Conference. It is formatted in
the style required for inclusion in the Battcon Conference Proceedings. An optional Abstract section may precede
this Introduction section.
Acceptance of an abstract does not guarantee acceptance of a paper. Your paper must be noncommercial
according to typical standards within the engineering and scientific communities. Including the name of an
instrument used to take data or conduct a test is not considered commercial. The Battcon Technical Committee
reserves the right to reject and not publish any paper deemed commercial in nature or which otherwise does
not meet conference standards, even if the abstract was accepted. The committee also reserves the rights to
solicit more papers than there are presentation slots, to select only the best of those papers for presentation,
and to edit papers for spelling, grammar, and layout.
All presenters must be registered attendees. Unless otherwise stated, the registration fee entitles the registrant
to attendance at conference sessions and the trade show, a copy of the Conference Proceedings, meal
functions, and a room at the conference hotel. The conference brochure describes exactly what is included. At
the conference, the presenter will attend a breakfast orientation meeting, where last minute questions will be
answered.

Submitting Copyright and Biography

Each paper presented appears in the Conference Proceedings, which is the conference record. A copyright
release, required in order to include the paper in the Proceedings, is due when the paper is submitted. Each
attendee receives a copy of the Proceedings, distributed on a Flash drive. Copies may be sold to individuals,
libraries, and organizations.
Battcon continually communicates with each presenting author. When you submit your abstract for
consideration, you will submit a biography form that describes your work, education or experience. This
biography is used to introduce you at the conference and may appear in the Proceedings, Program Guide, and
Battcon Web site.
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Publishing a Paper and Recording a Session

This section addresses paper originality and recording at the conference.

Publication Elsewhere

Papers are expected to be essentially original and not published or presented elsewhere before the conference,
either to a general or similar audience. The Conference Proceedings is copyrighted, for the protection of the
authors and Battcon. A copyright release, which includes a statement that the manuscript is original and
previously unpublished, is required in order to publish the paper. Authors are free to reprint or republish their
papers elsewhere after the conference, provided the Conference Proceedings is cited as follows: Conference
Proceedings, Battcon 2017, Vol. 1, 2017.

Image and Sound Recording

Battcon reserves the right to photograph, video record and/or audio record throughout the conference,
including paper presentations, panel sessions, seminars, Q&A sessions, trade show, and extracurricular
activities. These recordings may be used by Battcon for promotion of future events or offered for sale or use
after the conference.

The Battcon Audience

Battcon is designed to meet the specific needs and interests of end-users of stationary battery systems.
Attendees are professionals working in the data center, UPS, power station, telecom, utility, healthcare,
petroleum, and nuclear industries, and in education, government, and the military. This international audience
has varying levels of education and experience.
Over 39% of the attendees are end users from facilities maintaining mission critical operations. Battery
maintenance specialists from service companies represent about 17%. Other substantial groups represent
battery and equipment manufacturers. Conference sessions address manufacturing, maintenance, and testing
issues. Papers are delivered by presenters who have research and development (R&D), manufacturing, servicing,
and end-user backgrounds.

Presenting at the Conference

Over three days, Battcon typically offers 19 papers with question and answer (Q&A) sessions, four panels
addressing various topics, and three workshops. The trade show is in the evening. Usually, three papers are
presented at a session, followed by a Q&A panel. Each presenting author at the session is one of the panelists.

Content of Your Presentation

Your presentation time lets you bring your paper to life. The presentation consists of an introduction, main
points, and a conclusion. The conclusion summarizes the main points and offers comment on future
development. Your talk should guide, instruct or inform. You may discuss new research, findings or
manufacturing issues, and you may elaborate on your background if it relates to the paper. Do not read your
paper or slides to the audience. Keep the material focused, and stay within your time limit.

Length of Presentation

Your presentation time is normally 20 minutes, which does not include Q&A time. Questions are held until all
speakers in a session have presented; there are no individual discussions after a paper. Practicing your
presentation until you are within your time limit ensures all your material will be covered.
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Battcon Presenter and Panelist Attire

Battcon has no fixed dress code. Most presenters and panelists wear business casual, such as a Polo style golf
shirt and slacks. A few may wear a sports coat and tie or a full suit if they prefer. On stage, the Technical
Committee members wear Battcon issued golf shirts and dress slacks. The majority of attendees wear business
casual. Please reserve shorts and T‐shirts for activities outside the conference.

Formatting: The Mechanics

Format your paper in the style of this document. Consistent margins, columns, and typeface help make for
better readability. Papers not formatted properly will be returned.

Paper Length

The maximum paper length is ten pages, including tables and illustrations. Shorter papers are not a problem.
Text must be single-column format.

Margins and Paper Size

The required paper size is 8½ by 11 inches (US letter size). Set the top, left, and right page margins to 0.75" and
the bottom margin to 1". The margins are listed in Figure 1.
•

Keep paragraph text together. Do this in Microsoft Word® as described in Headings and Text Styles.

•

Do not place photographs, figures or tables on the first page.

•

Bullets may be used as illustrated here; however, other borders and markings are discouraged because
they tend to distract the reader.

Headings and Text Styles

For the title of the paper, use upper/lowercase Calibri 14 point bold, centered on the page. Put one blank line
after the title. Figure 2 summarizes fonts and spacing.
For the author's name and affiliation, use upper/lowercase Calibri 12-pt bold, centered, followed by two blank
lines. Show each author's name and include job title, company, city and state. Do not insert street address, email
address or telephone number. Do not use titles such as Dr. or Ph.D. or professional society membership. If all
authors are from the same company, show the company name and location once, centered on the page.
For major headings, use upper/lowercase Calibri 14-pt bold, aligned left. For subheadings, use upper/lowercase
Calibri 12-point bold, aligned left.
For body text, use Calibri 11-pt, aligned left (ragged right margin). Single space body text. Do not indent
paragraphs. Put one blank line after paragraphs.
Do not break a paragraph across an illustration or from one page to the next. In Word 2007 and 2013, select all
the text, click the Home tab | Paragraph section down arrow | Line and Page Breaks tab, and check the Keep
Lines Together box.
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Automated Word Styles Option

To help with formatting, you may use the automated styles that reside in the Microsoft Word version of this
document. These styles may also be imported into a new Word document. To display the list of styles, click the
Home tab then click the Styles drop-down menu. Names of styles used in this document begin with "Paper",
such as "Paper Body Text 11pt." Some styles insert a blank line automatically. A blank Word template is also
available and may be used if you prefer.

Page Numbering

Center the page number in the page footer. Battcon assigns the paper number and adds it to the page number.
For example, if paper number 3 has four pages, the page number format is 3-1, 3-2, 3-3 and 3-4.
Figure 1. Margins and Basic Layout
Item

Page

Description

Margins

All

Top, left and right margins 0.75" and bottom margin 1.0".

Authors and
Affiliations

1

On the first page, centered.

Page Numbers

All

Centered in the footer of each page. The format [Paper Number] [Page Number] is used. Battcon assigns the Paper Number.

Figures and Tables

All except Page 1

Do not put figures and tables on the first page. They should not
break across pages if practicable. If a table breaks across pages, put
column headers on each portion of the table.

Spelling and Grammar

Battcon may edit papers for spelling, grammar, and layout or recommend changes to the author. Have another
person proofread your paper. Nothing replaces a human editor. Be wary of spell checkers that cannot catch
frequently misused words such as: its (it's), ensure (insure, assure), manufacturer (manufacture), a (an), discrete
(discreet), and complement (compliment). Note the books cited in the Bibliography section of this paper.

Use of Color

Any illustration, chart, graph or photo may be in black and white or color but should be in colors that are easily
discernible so data is evident. Text, however, must be in black.

Figures, Tables, Illustrations and Captions

Figures, tables, and illustrations must fit within the defined margins, centered on the page. Do not distort
illustrations; decrease their size proportionally. In tables, use Calibri 11-point for text. Center the caption above
the table or in the top row. Use bold for the column headings and the caption. Separate the table with caption
from other text by one blank line.
For captions for other than tables, use Calibri 11-point bold, and center the caption below the figure. Separate
the figure with caption from other text by one blank line.
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Figure 2. Fonts, Justification, and Spacing
Text Sample

Description

Paper Title

Upper/lowercase Calibri 14 point bold, centered. One blank line after.

Author's Name
Company
City/State

Upper/lowercase Calibri 12 point bold, centered. Two blank lines after the City, State.

Major Heading

Upper/lowercase Calibri 14 point bold, aligned left.

Subheading

Upper/lowercase Calibri 12 point bold, aligned left.

Body Text

Calibri 11 point, single spaced, aligned left. One blank line after paragraphs.

Page Number

Calibri 10 point, centered in the footer of each page.

Table Caption

Upper/lowercase Calibri 11 point bold, centered, preceding or as part of the table at
the top. One blank line before the caption/table and after the table.

Table Text

Upper/lowercase Calibri 11 point. Format table text for ease of reading.

Figure Caption

Upper/lowercase Calibri 11 point bold, centered below the figure. One blank line
before the figure and after the caption. No space between the figure and caption.

Photographs and Other Images

The use of photographs is discouraged, as they often do not reproduce well. If using photos, use no more than
two. Do not distort photographs; decrease their size proportionally. If preparing a PowerPoint® presentation,
consider placing the photos into your slides instead.
Inserting a picture is preferable to pasting it in. After inserting a photo or other image in Word 2007 or 2013,
click the image and format using Picture Tools | Format Picture. Under Position and also under Text Wrapping /
Wrap Text, typically select In Line with Text. Do NOT insert a picture into a text box. Do not link the picture to a
file.

Creating Slides

Slides augment your presentation by providing structure, emphasizing key points, illustrating concepts, and
showing formulas and results. Remember, slides complement or supplement your presentation; they should not
be an integral part. Do not read the slides verbatim to the audience, and do not prepare more slides than can be
discussed in 20 minutes.
The inclusion of video within a slide presentation is not allowed, due to variations among the different versions
of PowerPoint and computer operating systems.

Correctly Sizing the Slides

In earlier versions of PowerPoint, slides were squarer (4:3). The current default slide size is widescreen (16:9).
Battcon requires all slides be in the 16:9 format.
If you are using PowerPoint 2007, change the slide size from standard (4:3) to widescreen (16:9) before you
begin to construct your slides. The size must not be changed after the slides are constructed, as this will severely
distort all images, text and graphs.
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To change the slide size in PowerPoint 2007 before creating your slides:
• Open PowerPoint 2007 and click the Design tab.
• Click the Page Setup button.
• On the Page Setup dialog box, on the Slides Sized For drop-down menu, select On-Screen Show 16:9.
• Click OK. The blank slide size changes from 4:3 to 16:9 format.
The default slide size in PowerPoint 2013 is the 16:9 format. If it is not already selected, to change the size
before creating your slides:
• Open PowerPoint 2013 and click the Design tab.
• Click the Slide Size button.
• On the drop-down menu, select Widescreen (16:9).
• The blank slide size changes from 4:3 to 16:9 format.

Slide Readability and Slide Count

Your slides will be presented in a room with over 600 people and must be readable. Try to use at least 44-point
type for headings and 32-point type for text. Do not use all capital letters. Limit the use of bold and italic. Slides
deemed unreadable will be returned.
Do not randomly construct pie charts; they have a definite order of construction. Avoid three dimensional
charts, as they are more difficult to interpret.
Limit slides to high contrast colors, such as a plain, light but not white background and dark text. Black text on a
dark blue background does not display well, nor does a yellow graph curve on a yellow background or a purple
curve on a black background. (All have appeared at the conference.) For charts and graphs, consider readability
and use colors of high contrast to show data.
Limit the use of a laser pointer, as multiple screens will be in use. Point to key elements in a photo or graph, not
to words. Some attendees are non-native speakers of English, so use standard vocabulary and avoid vague
references and clichés.
Keep the number of slides in your presentation to 22 slides or less. Transition slides count towards this total. It's
a matter of giving the attendees time to absorb the content of each slide. Keep the PowerPoint file size under
5 MB. IMPORTANT: Run your slide presentation on a computer other than the computer on which the
presentation was created. This will check for missing photos, images and fonts.
Keep the slide presentation noncommercial. Incorporating company advertising or emphasizing brand markings
in slides are prohibited, but an inconspicuous logo on one or more slides is acceptable. You may put your
contact information on the last slide. The Battcon Web site has an optional slide template you may use.

Audiovisual Equipment

Battcon provides a computer, projector, and microphone. Contact Pam McCombs at
pam.mccombs@emerson.com if you have any special equipment needs. There may be a charge for special
equipment.
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Final Documentation

Handouts are neither necessary nor permitted, as your paper will appear in the Proceedings. Please spell check
the paper. Print the paper on 8½ x 11 inch paper and proofread it. Check for missing words, unusual page
breaks, and illustrations that do not print clearly. Your attention to detail will be appreciated by all at the
conference. If you have questions, contact:
Jack Mack, Battcon Publications, at jack.mack@emerson.com or
Pam McCombs, Marketing and Event Manager, pam.mccombs@emerson.com
Liebert Corporation, an Emerson Network Power Company
530 Westar Blvd., Westerville, OH 43082

Due Dates

Email the abstract or final paper as a Word attachment to Jack Mack at jack.mack@emerson.com. The paper is
reproduced at 100% size from the file. Contact Battcon if you do not receive confirmation of receipt.
An abstract may be submitted via email until late January. A biography form, available on the Web site, must
accompany the abstract.
Submit the final paper by mid-February or upon approval of the abstract. A copyright release form, also on the
Web, must accompany the final paper. (Or you may surface mail the copyright release.) Receipt of the copyright
release is mandatory.
If using PowerPoint slides, back up the file onto a CD or Flash drive and take it to the conference. You are
responsible for both submitting your PowerPoint file well before the conference and for having your file at the
conference. Although PowerPoint is ubiquitous, computers do fail, and Battcon cannot guarantee availability of
your PowerPoint file. Files not reviewed in time might not be available the day of your presentation.
You must email the PowerPoint file for review and installation onto the conference computer. Email the
PPT/PPTX file by mid-March, or upon approval of the paper, to jack.mack@emerson.com. Presentation
materials are not distributed at the conference.
A deadline extension may be granted for extenuating circumstances. Papers received after the publication date,
however, might not appear in the Conference Proceedings. Individual copies of papers are not distributed at the
conference.

Summary

For brevity, this section is not an actual summary. We at Battcon hope this guide helps you with your paper and
presentation. Feel free to contact Battcon with any questions, and remember that the latest Battcon
information is on the Web at www.battcon.com. For your information, this document was reviewed and
extensively revised in November of 2015. Comments about this document are appreciated. Please direct any
comments to jack.mack@emerson.com.
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The References section lists material cited in the text. List references at the end of the text, under a References
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